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BASIC PARTS OF EXCEL SCREEN

Screen Layout
Basic anatomy of the Excel screen:

Quick Access Toolbar Title bar

Formula Bar Close button

File tab
Ribbon
Mame a1
box | A ! ] C 1] T F a ] 1 § L3 L B
;I=—_!—Active cell | ]
: Columns
Rows
- Scroll
:: bars
t = Shoril 4 0 ¥ .
famdy "‘_'_I e 1 T
Worksheet tabs

View buttons Zoom slider

Save Button

Click the save button in the Quick Access Toolbar to save the Excel file. It can be clicked at any time.
You will lose your work if the Excel file is closed without saving. The save button is your friend; use it
often.

Undo Button

The undo button, located in the Quick Access Toolbar, allows you to correct mistakes by reverting
to a previous action. For example, if you accidentally deleted a row after building a table, click the
undo button to restore the deleted row. Your actions are tracked in Excel, so you can press undo
multiple times to reverse several actions. It's important to note that previous actions are not saved
after closing the Excel file. The undo button will only work for new actions after you reopen the
Excel file.
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File Tabs

Each tab contains a row of buttons, and each button performs a different function. The Home
tab is the most commonly used. Even experienced Excel users may not know the function of
every button in every tab. It's best to get comfortable using some of your favorite functions and

experiment with others. You can also look them up on Google or take advanced Excel classes to
gradually learn more.

Bookl - Excel

Insert | Page Layout | Formulas | Data | Review | View | Developer

Formula Bar

This bar displays the text typed into a cell. After selecting a cell, you may find it helpful to click on
the formula bar to input the contents you want to appear in the cell, especially if the contents are
lengthy. This area is useful for entering long formulas, which is why it's called the formula bar.

= Book1 - Excel
Insert | Page Layout | Formulas | Data | Review | View | Developer | Q Tellme.. Wesley M... ,Q,_Share
—] % Calibri - - = — =3 General » F@Conditional Formatting - @ o
D EE="NB T VLSS AR G = = = - % - 9% » [4FormatasTable~ -
Paste | . o _ Cells  Editing
- e | O A~ == - = [7 Cell Styles - - -
Clipboard & Font P Alignment w  MNumber Styles ~
Y e Y e
Fs b Je v
[ ——————————————————.——————————————.—
Sheet Tabs

At the bottom of the Excel grid, you'll find sheet tabs. A sheet is a new spreadsheet or grid within
the same file that keeps data separate from other sheets but in the same file. For instance, a
department may use different sheets to keep track of staff birthdays for each unit within the
department. You can switch between sheets by clicking on the sheet name. By default, the sheet
names are Sheetl, Sheet2, and so on. Clicking Sheet2 would open that sheet. To rename a sheet,

double-click on the sheet name with the left mouse button and type a new sheet name. To create a
new sheet, click the symbol shown below.

Close Button

Once you're finished working on the document and saved it, you are ready to close it. The close
button is located in the upper-right corner of Excel. When your mouse is near the “X” in the upper-
right corner, the area will turn red. Click on the “X" to close the file.

= = X Eal = X
S

EXCEL REFERENCE GUIDE 4



CELLS, COLUMNS AND ROWS

Select a Cell

A cell is any single rectangular space in the spreadsheet grid. To select a cell, simply click on it.
Once selected, a cell will have a dark green border with a tiny solid green square in the lower right
corner. The address of the selected cell is displayed in the Name Box, indicated with a red dashed
line below. The cell address consists of the column letter followed by the row number. You can
enter data into a selected cell, such as numbers, letters, dates, times, symbols, alphanumeric codes,
names, telephone numbers, paragraphs, and Excel-compatible formulas.

2
i | l:l 3 | |555-555-5,.k55

>

You can select multiple cells at once by 1) clicking and holding the left mouse button on one cell,
2) dragging the mouse pointer over as many adjacent cells as you'd like, and 3) letting go of the
mouse button. Selected cells (or columns or rows) are called a range.

Select a Row

Row headings are the numbers along the left side of the spreadsheet. To select a row, click on the
row number, which is circled in red below. The row is now selected.

L3J_ 555-555-5555

4

You can select multiple rows at once by 1) clicking and holding the left mouse button on the row
heading, 2) dragging the mouse pointer over as many adjacent row headings as you'd like, and 3)
letting go of the mouse button.
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Select a Column

Column headings are the letters along the top of the spreadsheet. To select a column, click on the
column letter.

A ()

555-555-5p55

~ W R -

You can select multiple columns at once by 1) clicking and holding the left mouse button on the

row heading, 2) dragging the mouse pointer over as many adjacent row headings as you'd like, and
3) letting go of the mouse button.

Select a Sheet
You can select the entire sheet by clicking the triangle between the column and row headings.

Insert a Column, Row or Cells
1) Right-click on the column heading.
2) Click on Insert. A new column appears to the left of the original column.

B r n
36 Cut

555-555-5 |, Paste Options:

D

Paste Special...

Insert I
B

Delete

Clear Contents

555-555-5555 Format Cells... ' ¥

Column Width...
Hi 555-555-5555
Hide

Unhide

> - >

As with columns, steps 1-2 work the same to insert a row(s) and nearly the same to insert a cell(s).
When inserting cells, however, you select the desired cells instead of a heading. Also, the existing

cells have to move to make room for the new cells being inserted, so you have to specify whether
you'd like to shift the existing cells right or down.
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Resize a Column or Row
When the cell's contents are longer than the cell itself, you can resize the column to make it wider.
1) Select the column.
2) Place the mouse pointer near the column edge in the column heading, and it will change
iNnto a resize cursor: ¢
3) Left-click and hold the resize cursor, then slide left or right to make the column any desired
width. (Alternatively, double-click the left mouse button on the resize cursor. The column will
automatically resize to fit the longest cell content in the whole column.)
4) Release the left mouse button.

B “+ B

555-555-5p51 a55-555-5550

>

As with columns, steps 1-4 work the same way with a selected row edge in row headings.

Edit Font Type & Size
1) Select the desired cell(s), row(s), column(s) or sheet.
2) On the Home file tab, click the font drop-down.
3) Click a new font.
4) Click on the font size drop-down.
5) Click on a new font size.

[ calibri B - A a ===

Theme Fonts |-
O Calibri Light {Headings)

O cCalibri {Body)

All Fonts

O Abadi MT Condensed
1O Abadi MT Condensed Extra Bold

Calibri OH - A A L T Abadi MT Condensed Light
E O lgency B
BT U- B DA |0 ALGRRIAN
Unit Status O Arial
— — 9 Fant Pt 9 9
Arial -l B
BIu-fM:°®

loove

! Font 5| ; S PUnlt Status

EXCEL REFERENCE GUIDE 7



Edit Font Color

1) Select the desired cell(s), row(s), column(s) or sheet.

2) Click the Font Color drop-down.
3) Click on a new font color.

Il
litl

A b
B Automatic

Theme Colors

m mmms jmn
.III||||||

Arial 14 -|A A Standdord Cor
tandard Colors
Bru-@- &0 m EEEEN
Unit Status vy More Colors..
i S Font M S I‘
Status
e lacia
Edit Fill Color
1) Select the desired cell(s), row(s), column(s) or sheet.
2) Click the Fill Color drop-down.
3) Click on a new fill color.
Arial -[14 A A
RERERCT
IS}atLls s - sl|
LA - | == = | &
Theme Colors N
HE EHER HE

Standard Colors

EE
No Fill

i8]

B i gy More Colors...

ovtTn 1

t
Pl
g

[Unit _ Status ]
i s
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Create Borders

Use borders to make the lines of the spreadsheet grid visible for printing or better viewing.
1) Select the desired cell(s), row(s), column(s) or sheet.

2) Click the Borders drop-down.
3) Click on a new fill color.

Unit Status

ECC

scu Calibri
MedSurg
Maternity L
OR

N

-
4
-
4
I
I[1]
1
Il
1$]

Bottom Border
Top Border
Left Border

Right Border
Mo Border
HH Al Borders
: Outside Borders
- Thick Qutside Borders

i Bottom Double Border

Thick Bottom Border
Top and Bottom Border

Top and Thick Bottormn Border

¢4 Top and Double Bottom Border

Draw Borders

-

¥ Draw Border

L;'* Draw Border Grid
Erase Border

[# Line Color 4

Unit Status

ECE

SCU

Line Style »

MedSurg

Maternity

HH More Borders...

OR
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Format Numbers

There are many ways to format numbers in Excel. 1) Select the desired cell(s), row(s), column(s) or
sheet. 2) Click the desired button in the Number area of the Home file tab. For this example, we'll

change a decimal to a percent.

General =

s () W

0.03 Number N
L >

T

Similarly, clicking the $ button would turn a number into a dollar amount. Other options exist. 1)
Click the Number Format drop-down. 2) Click the desired number format. Alternatively, if you don'’t
see the desired number format listed, click More Number Formats... at the bottom of the list.

3

General

=
[
o

Ne specific

Number

—
I

Currency

|
(ll
[=

Short Date

il

Long Date

Time

q Percentage
0

]/ Fraction
2
102 Scientific

ABC Text

General
$-% » %%

Mumber ] —

Accounting

More Number Formats...

format 1

>
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Fill Handle

The fill handle is one of the most time-saving features in Excel. Excel automatically identifies
common sequences and can complete sequential patterns for you. For example, if you type “1" in
one cell and then type “2" in the cell immediately below or immediately to the right of the “1” cell,
Excel will list the next consecutive numbers (“3, 4,5, 6, 7...") in the cells that follow when using the
Fill handle. The Fill handle works for days of the week, months of the year, dates, and many other
patterns. It works backward and forward, horizontally across columns and vertically across rows.
Manually typing a series is an inefficient use of Excel; let the program do the work for you. 1) Select
the cells with the pattern. 2) Click and hold the dark green square, usually located at the lower right
corner, of the selected cells. 3) Drag the Fill handle across the desired range of cells and release the
mouse button. Two examples are shown below.

1 1

2 2

3

4

5

6

7

8

1 9

=] > |19
Sun Monl9 fsun Mon | |9 [sun Mon Tue Wed Thu Fri  sat |

Align Cell Contents
Alignment is used to make the cell contents centered or abutted against the right or left side of a
cell. 1) Select the desired cell(s), row(s), column(s) or sheet. 2) Click the desired alignment button.

ECC ECC
scu == = - EL,(- Wrap Text scu
MedSurg T MedSurg
Maternity = =N S=r2= Merge & Center ~ Maternity
OR Al . OR

S Alignment ] S
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Wrap Text

When the cell's contents are longer than the cell itself, you may want the cell contents to adjust to
fit the existing column width by expanding the row. This is especially useful when the cell contains
a lot of text. 1) Select the desired cell(s), row(s), column(s) or sheet. 2) Click Wrap Text in the

Alignment area of the Home file tab.

Merge & Center Cells
Merge & Center is useful for center headings over a table. 1) Select the desired cell(s). 2) Click the
Merge & Center button.

Unit Status
ECC N/A
SCU This cell containd a great deal of text to demonstrate the wrap text feature.
MedSurg  |N/A
Maternity |N/A
OR N/A
= = = € 3= [ Merge & Center -
9 Alignment F 9
Unit Status
ECC N/A
This cell
contains a great
deal of text to
demonstrate
the wrap text
SCU feature.
MedSurg  |N/A
Maternity |N/A
OR N/A

Daily Results by Unit | ==_ - EWapTet
Sun Mon Tue Wed Thu Fri  Sat = ==
=B = | £= 2= erge & Center ~
ECC| 5 0 9 6 T 4 3
SCuU 3 5 2 4 3 4 i | 9 Alignment I 9
Daily Results by Unit I
Sun Mon Tue Wed Thu Fri Sat
ECC| 5 0 9 6 7 4 3
SCU| 3 5 2 4 3 4 1
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Copy and Paste

Excel offers a variety of paste options for copied cells. 1) Select the desired cell(s), row(s) or column(s)
to be copied. 2) Click the Copy button. 3) Select the desired cell(s), row(s) or column(s) where you'd
like the copied cells pasted. 4) Click the Paste drop-down. 5) Click the desired Paste button. A few
of the more common paste options are shown below.

X Cut ;X Cut
D CE Copy D ER Copy ~
—TATT TVTOTT TO= Paste - (=

= ¥ Format Painter ¥ Format Painter
ECC| 5 1] 9 | |
ceri | o = o -> Clipboard 2 . > Clipboard > ...

P

-n..‘ a6 Cut

ER Copy ~
Paste =
- ¥ Format Paintg
Paste

= g o

k2% 1S

s s,

€3> | B

{=u]

Paste Values
el

F
123 123 "123
Other Paste Options

s,  alm, el

%,
] =)
& loo L GD[—I

Paste Special...

e > ] B 0 > |[Pc:ls‘re]

B ) 36 Cut
ER Copy -~

- ~ Format Painté]

Paste Values
o

P
123 123 "2
Other Paste Options

e, s, el

vy
] s
ﬁs‘ o Ll GD[—|

Paste Special...

ecc|l 5 | o | 9 |

[Keep Source Column Widths]
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o X, Cut

D ER Copy ~
om PY
= ~ Format Paints

-

Paste Values
el [
123 *123 %123

Other Paste Options

ﬁ ey ale sl
J )
& loo L c@

Paste Special...

e e .=

F
123123 123
Other Paste Options

ﬁ‘&ﬂﬂ
¥ m@%l

Paste Special...

ECC
5
0
9
21 [Transpose]
[ecc 5 0 9|

[Values]
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TABLES, FUNCTIONS, CHARTS

Tables
Tables make it easier to work with data, including graphs and functions. Plus, you can select
columns or rows of data by clicking on the respective table headings.

1) Select the desired cells to be turned into a table.

2) On the Insert File tab, click the Table button.

3) If you have column

headmgs for your data, Sun Mon Tue Wed Thu Fri Sat
ensure the “My table Eccl s | o |9 |6 | 7| a]3s
has headers” box is Scul 3 | 5 | 214 13 | 4|1 E; D
checked. Click OK. MedSl.!rg 2 8 ° 8 ! 8 2 PivotTable Recommended Table
Maternity| 1 1 4 8 5 7 5 TRl
OR| 7 2 il 3 1 2 4
9 Tables 9
Create Table ? x
Where is the data for your table? ﬂ ﬂ MOH ﬂ Wen ﬂ Filkd -
=5053:5/58 505 ECC| 5 0 o 6 7 4 3
SCU| 3 5 2 4 3 4 1
| My table has head
7] My table has headers MedSurg| 2 8 6 8 7 8 4
Maternity 1 12 4 8 5 7 5
“ Cancel OR 7 2 Al 3 1 2 4
9

Sort
Sort is used to arrange data from largest to smallest or vice versa. In a table, this feature is already
built into the column headings. For this example, we'll sort smallest to largest by data in the
Tuesday column.

1) Click the desired column drop-down in the table's

Column headings' ‘_l Sort Smallest to Largest
2) Click Sort Smallest to Largest. B Bl iages ot
3) Click OK. The table is now sorted based on the Sost sy Ecks '
re-ordered data in the Tuesday column.
MNumber Filters »
Search yol
[ (Select All)

1

-6
Lovl g

B M vl K well H rll E
ECC B 0 9 6 7 4 3
SCu 3 3 2 4 3 4 1
MedSurg| 2 8 6 8 7 8 4
Maternity 1 12 4 8 5 7 5 - Cancel
OR 7 2 1 3 1 2 4
> >
v v ol =t v v v v

OR 7 2 1 3 1 2 4

SCU 3 5 2 4 3 4 1

Maternity 1 12 4 8 o i D

MedSurg| 2 8 6 8 7 8 4

To remove a sort, click the undo button. ECC| 5 0 9 6 7 [ 4] 3
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Filter
Filter is used to “filter out,” e.g., remove certain data from view. When you filter data, nothing is
erased; rather, the data simply becomes non-viewable as long as the filter is on. You can turn off
filters at any time. In a table, this feature is already built into the column headings. For this example,
we'll filter out all data from the table except for ECC and SCU rows.

1) Click the desired column drop-down in the table's column headings.

2) Click the (Select All) box to uncheck it. This will uncheck all values.

3) Click the boxes for ECC and SCU.

4) Click OK. The whole table is now filtered of data not pertaining to the ECC and SCU.

8] SortAtoZ
Zl sortZtoA
Sort by Color > }
|
Text Filters 4
Search yo
1+ detect a1y

cc
Maternity
¥ MedSurg
i[#] OR

L[ scu
- - Yy - - - - - -
OR| 7 2 1 3 1 2 4
SCU| 3 5 2 4 3 4 1
Maternity| 1 12 4 8 3 7 5
MedSurg| 2 8 6 8 7 8 4 Cancel
EEE | RS 0 9 6 7 4 3
>l >
8l SortAteZ | 2l SortAtoZ
El SortZto A J Z| SortZtoA
Sort by Color L Sort by Color ’
Text Filters » Text Filters »
Search yo Search P
ECC

0K Cancel I Cancel

. > >
vY 7 D hd o v b v o
SCU| 3 5 7 3 4
ECC 0 9 6 4 3
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To turn off the filter, 1) Click the column drop-down with the filter icon . 2) Click Clear Filter From
“Unit.” 3) Click OK. The filter is now removed from the table.

T N
—

—

SortAto Z
SortZto A

Sort by Color

. Clear Filter From "Unit"

Text Filters 3
Search ye
V| (Select All
M ECC
-] Maternity
D MedSurg
~[]OR
[l scu
| D Badl o b
sCu 5 2 4 3 oK Cancel
ECC 0 9 6 ¥y
9
X [ - - -
OR 7 2 1 3 1 2 4
SCU 3 D 2 4 3 4 1
Maternity| 1 12 4 8 5 i 5
MedSurg| 2 8 6 8 7 8 4
ECC 5 0 9 6 7 4 3
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Basic Functions

Functions make Excel powerful at making your life easier. Functions can perform math, find data in
a column, use logic to determine whether to count individual values for a calculation and so much
more. Excel users looking to become stronger users are advised to learn more functions. Two basic
functions, SUM and AVERAGE, are shown below.

SUM

As the name implies, the SUM function is used to add the values in a selected range. A “Total”
column or row in a table is the perfect location to use the SUM function. The steps below include
creating a “Total” column in the table, although these steps (1 and 2) are not required to use the
SUM function. 1) In the cell adjacent to the last table column heading, type “Total.” 2) Press Enter.
Excel will automatically create a new table column for you. 3) The cell below the heading is where
we use the SUM function. As that cell is already selected, go to the Formulas File tab and click
AutoSum. All row values are automatically selected, and the formula is displayed. 4) Press Enter.
The sum of the first row values is now displayed. 5) To use the SUM function for all rows in the table,
use the Fill handle, or click the AutoCorrect button that appeared after clicking Enter. 6) Click
Overwrite all cells in this column with this formula. The sum of the row values is now displayed

for all rows.
- - 0 Rd - = ¥ - - | Total | - -
OR| 7 2 1 3 1 2 4 I a
SCuU 3 5 2 4 3 4 1 1
Maternity 1 12 4 8 o 7 5 5
MedSurg| 2 8 6 8 7 8 4 4
EGC > 0 3 6 7 4 3 3
> 4>

Insert Page Layout Formulas Data Review View

SEE@ECE R @

AutoSum Recently Financial Logical Text Date & Lookup & Math &  More
Used ~ v = *  Time~ Reference~ Trig~ Functions~

Function Library

= = ol = el - = E-Z
ORp__ 7 | 2 1 3 _1 =SUM(TabIe1[@[Sun]:[Sat]]b a 20
SCU 3 5 2 4 3 4 | SUM(number1, [number?], ...) 1 l__'?I
Maternity| 1 12 4 8 o 7 3 5
MedSurg| 2 8 6 8 g 8 4 4
ECC|l 5 0 9 6 7 4 3 3
£ 9 F 9

20
22

42
i |
43
Overwrite all cells in this column with this formula I 34
9 a
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AVERAGE

The AVERAGE function displays the mean (average) of all numbers in a selected range. For this
example, we'll calculate the average of all values in the table but in a cell by itself. The AVERAGE
function does not need to be used separately from a table. This example is shown purely to
demonstrate a different but equally common approach for using functions. Also, the steps below
include creating an Average: label, although steps 1and 2 are not required to use the AVERAGE

function.

1) Click any cell that is several cells to the right of the table (so the table does not automatically
try to add it as a new column or row). In the cell, type “Average:”
2) Press Tab. One cell to the right is now selected.

3) In the Formulas File tab, click the AutoSum drop-down.

4) Click Average. The cell now shows the AVERAGE formula with empty parenthesis. This

means that Excel is waiting for a data range to be selected.

5) Select a range of cells that contains the data. In this example, we'll use all the data in the
table, excluding headings and the Total column. Simultaneously, the cell with the formula
will automatically insert the range you've selected into the formula.

6) Press Enter. The average of all values in the table is now displayed.

|Average: _I9 AveragE::!e Audm ->

2

Used ~

&=

AutoSum Recently Financia

Z Sum

Average

Count Numbers

IV

dx

Mi

in

More Functions...

Average:l =AVERAGE()

AVERAGE(number1, [number2], ...)

9
M K vl K well K M H z
OR! 7 2 1 3 1 2 4 1] 2
scul 3 5 2 a 3 4 1] 2
Maternity] 1 12 4 8 5 7 5 l 42
MedSurgi 2 8 6 8 7 | s8] a1 a
ecci s | o [ 9 | 6 | _ 7 | a [ 31 =
Average:l=AVERAGE(TabIelf:Sun]:jSat]]}
AVERAGE(number1, [numberl], ...) N Average: 4.6
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Basic Charts

A chart is a visual representation of data. Complex data create complex charts. Simple data create
simple charts. As a rule, the simpler, the better. To create a chart, first format data to be as simple as
possible. Pie Chart and Bar Chart examples are shown in this section. For both examples, based on
the table used in previous examples, we decided that we only want our charts to display the data in
the Totals column. Plus, to ensure our data is labeled correctly, we will also use the row headings in

the Unit column.

1) Copy the Unit table column and paste values several cells right of the table.
2) Copy the Total table column and paste values to the immediate right of the Unit column

values.

3) Select all newly pasted cells, and click the Table button on the Insert File tab. We will now
use this new table for charts in the following examples.

|-;I Unit [Fotal - Unit Total Unit Total
OR OR 20 OR 20 OR 20
SCU SCu 23 5CuU 22 SCU 22
Maternity Maternity 42 Maternity 42 Maternity 42
MedSurg MedSurg 43 MedSurg 43 MedSurg 43
ECC ECC ECC 34
5 34 ] ECC 341 EN N >

| p— | OR 20

g B SCu 22

PivotTable Recommendeﬁ Table Maternity 42

PivotTables MedSurg 43

Tables > ECC 34

EXCEL REFERENCE GUIDE 20



Pie Chart

Select the table.

On the Insert File tab, click the Insert Pie Chart button.

Click on the Pie button. The data is now converted into a pie chart. Clicking on the chart title
will allow you to change the heading. This chart may be copied and pasted, including into a
Word document or a PowerPoint.

Unit ﬂTotaI -

FIvOLTTdIT

- -

2-D Pie

Qe Q=

Doughnut
o [ g I-v |II' | | e
12 - 13 |1 ()
Recommended . PivotChart N2
Charts 1 b=-k- . »
Charts = @® More Pie Charts...
Total

mOR =5CU = Maternity

MedSurg = ECC
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Bar Chart

Select the table.

On the Insert File tab, click the Insert Bar Chart button.
Click on the Clustered Column button. The data is now converted into a bar chart. Clicking
on the chart title allows you to change the heading. This chart can be copied and pasted,

including into a Word document or a PowerPoint.

- I2- 1% e g 1

2-D Column

iln

=

BA (A1

i

3-D Column

o 08 99

2-D Bar
== [@= [
I— " | |
unit K rotal K3
OR 20 3-D Bar
scu 22 = tif ="~ n )
Nhtemrtvl 42 I? W il - - .I % % %
Recommended PivotChart .
MedSurg 43 Chate v ke B ,
ECE a4l Charts 5 > |kl More Column Charts...
Total

50

45

40

35

30

25

20

15

10

5

0

OR sCu Maternity MedSurg ECC
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ORIENTATION & PRINT

Orientation

Orientation allows you to change how a page is arranged to print. The options are either Portrait
(taller) or Landscape (longer). An Excel document will be set to Portrait by default, so use this

option to change to Landscape.

1) Click the File tab named File.

2) Click Print.
3) Click Portrait Orientation.

4) Click Landscape Orientation. The page is now set to print sideways/landscape.

Settings

lj Print Active Sheets .

Only print the active sheets
Pages: 2| to -
Print on Both Sides

Flip pages on long edge

Collated

BE ., .., -

.23 123 123

D] Portrait Orientation -

|:| Letter
85" x 1"

@ Maormal Margins
Left: 0.7" Right 0.7"

[ Mo Scaling .

100 Print sheets at their actual size

Page Setup

D Eettemt Cirientation -

D Portrait Orientation

D Landscape Orientation
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Printing on One Page
Large amounts of data often go off a single page in Excel. Luckily, you can make it fit on one page

for printing.

1) Click the File tab named File.

2) Click Print.

3) Click No Scaling.

4) Click Fit Sheet on One Page. The page is now set to print on one page.

Be aware, however, that too much data squeezed onto one page may make the font so small that it
becomes unreadable. In these circumstances, you may try the Fit All Columns on One Page or Fit

All Rows on One Page buttons to make a couple of pages of readable information.

RESOURCES

The best resource is Google. Even expert Excel users do a Google search that begins with, “Excel,

Settings

Print Active Sheets

Only print the active sheets
v| to -

Print on Both Sides

Flip pages on long edge

Collated

1,23 1,23 123

Portrait Orientation -

Letter

8.5"x 11"
Marmal Margins
Left 0.7" Right: 0.7"

Mormal Margins
Left 0.7 Right 0.7

100

Mo Scaling

-
Print sheets at their actual size

Page Setup

[ JJ MNoScaling -
[F100  Pprint sheets at their actual size
Mo Scaling
EE Print sheets at their actual size
+ Fit Sheet on One Page
"l;" Shrink the printout so that it fit
on one page
Site Fit All Columns on One Page
ﬁ Shrink the printout so that it is
one page wide
¥ Fit All Rows on One Page
[*h[ Shrink the printout so that it is

one page high

Custom Scaling Options...

how do I...” If Google doesn't help, ask colleagues. If all else fails, submit a help desk ticket.
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	BASIC PARTS OF EXCEL SCREEN
	BASIC PARTS OF EXCEL SCREEN
	BASIC PARTS OF EXCEL SCREEN

	Screen Layout
	 
	Basic anatomy of the Excel screen:


	Figure
	Save Button
	Save Button
	 
	Click the save button in the Quick Access Toolbar to save the Excel file. It can be clicked at any time. 
	You will lose your work if the Excel file is closed without saving. The save button is your friend; use it 
	often.


	Figure
	Undo Button
	Undo Button
	 
	The undo button, located in the Quick Access Toolbar, allows you to correct mistakes by reverting 
	to a previous action. For example, if you accidentally deleted a row after building a table, click the 
	undo
	 button to restore the deleted row. Your actions are tracked in Excel, so you can press undo 
	multiple times to reverse several actions. It’s important to note that previous actions are not saved 
	after closing the Excel file. The undo button will only work for new actions after you reopen the 
	Excel file.


	Figure
	File Tabs
	File Tabs
	 
	Each tab contains a row of buttons, and each button performs a different function. The 
	Home
	 
	tab is the most commonly used. Even experienced Excel users may not know the function of 
	every button in every tab. It’s best to get comfortable using some of your favorite functions and 
	experiment with others. You can also look them up on Google or take advanced Excel classes to 
	gradually learn more.


	Figure
	Formula Bar
	Formula Bar
	 
	This bar displays the text typed into a cell. After selecting a cell, you may find it helpful to click on 
	the formula bar to input the contents you want to appear in the cell, especially if the contents are 
	lengthy. This area is useful for entering long formulas, which is why it’s called the formula bar.
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	Sheet Tabs
	Sheet Tabs
	 
	At the bottom of the Excel grid, you’ll find sheet tabs. A sheet is a new spreadsheet or grid within 
	the same file that keeps data separate from other sheets but in the same file. For instance, a 
	department may use different sheets to keep track of staff birthdays for each unit within the 
	department. You can switch between sheets by clicking on the sheet name. By default, the sheet 
	names are Sheet1, Sheet2, and so on. Clicking Sheet2 would open that sheet. To rename a sheet, 
	double-click on the sheet name with the left mouse button and type a new sheet name. To create a 
	new sheet, click the symbol shown below.


	Figure
	Close Button
	Close Button
	 
	Once you’re finished working on the document and saved it, you are ready to close it. The close 
	button is located in the upper-right corner of Excel. When your mouse is near the “X” in the upper-
	right corner, the area will turn red. Click on the “X” to close the file.
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	CELLS, COLUMNS AND ROWS
	CELLS, COLUMNS AND ROWS
	CELLS, COLUMNS AND ROWS

	Select a Cell
	 
	A cell is any single rectangular space in the spreadsheet grid. To select a cell, simply click on it. 
	Once selected, a cell will have a dark green border with a tiny solid green square in the lower right 
	corner. The address of the selected cell is displayed in the Name Box, indicated with a red dashed 
	line below. The cell address consists of the column letter followed by the row number. You can 
	enter data into a selected cell, such as numbers, letters, dates, times, symbols, alphanumeric codes, 
	names, telephone numbers, paragraphs, and Excel-compatible formulas.


	Figure
	You can select multiple cells at once by 1) clicking and holding the left mouse button on one cell, 
	You can select multiple cells at once by 1) clicking and holding the left mouse button on one cell, 
	You can select multiple cells at once by 1) clicking and holding the left mouse button on one cell, 
	2) dragging the mouse pointer over as many adjacent cells as you’d like, and 3) letting go of the 
	mouse button. Selected cells (or columns or rows) are called a range.

	Select a Row
	Row headings are the numbers along the left side of the spreadsheet. To select a row, click on the 
	Row headings are the numbers along the left side of the spreadsheet. To select a row, click on the 
	row number, which is circled in red below. The row is now selected.
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	You can select multiple rows at once by 1) clicking and holding the left mouse button on the row 
	You can select multiple rows at once by 1) clicking and holding the left mouse button on the row 
	You can select multiple rows at once by 1) clicking and holding the left mouse button on the row 
	heading, 2) dragging the mouse pointer over as many adjacent row headings as you’d like, and 3) 
	letting go of the mouse button.


	Select a Column
	Select a Column
	Column headings are the letters along the top of the spreadsheet. To select a column, click on the 
	Column headings are the letters along the top of the spreadsheet. To select a column, click on the 
	column letter.
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	You can select multiple columns at once by 1) clicking and holding the left mouse button on the 
	You can select multiple columns at once by 1) clicking and holding the left mouse button on the 
	You can select multiple columns at once by 1) clicking and holding the left mouse button on the 
	row heading, 2) dragging the mouse pointer over as many adjacent row headings as you’d like, and 
	3) letting go of the mouse button.

	Select a Sheet
	You can select the entire sheet by clicking the triangle between the column and row headings.
	You can select the entire sheet by clicking the triangle between the column and row headings.
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	Insert a Column, Row or Cells
	Insert a Column, Row or Cells
	 1) Right-click on the column heading.
	 1) Right-click on the column heading.

	2) Click on Insert. A new column appears to the left of the original column.
	2) Click on Insert. A new column appears to the left of the original column.


	Figure
	As with columns, steps 1-2 work the same to insert a row(s) and nearly the same to insert a cell(s). 
	As with columns, steps 1-2 work the same to insert a row(s) and nearly the same to insert a cell(s). 
	As with columns, steps 1-2 work the same to insert a row(s) and nearly the same to insert a cell(s). 
	When inserting cells, however, you select the desired cells instead of a heading. Also, the existing 
	cells have to move to make room for the new cells being inserted, so you have to specify whether 
	you’d like to shift the existing cells right or down.


	Resize a Column or Row
	Resize a Column or Row
	When the cell’s contents are longer than the cell itself, you can resize the column to make it wider.
	When the cell’s contents are longer than the cell itself, you can resize the column to make it wider.

	1) Select the column.
	1) Select the column.

	2) Place the mouse pointer near the column edge in the column heading, and it will change 
	2) Place the mouse pointer near the column edge in the column heading, and it will change 
	into a resize cursor:

	3) Left-click and hold the resize cursor, then slide left or right to make the column any desired 
	3) Left-click and hold the resize cursor, then slide left or right to make the column any desired 
	width. (Alternatively, double-click the left mouse button on the resize cursor. The column will 
	automatically resize to fit the longest cell content in the whole column.)

	4) Release the left mouse button.
	4) Release the left mouse button.


	Figure
	As with columns, steps 1-4 work the same way with a selected row edge in row headings.
	As with columns, steps 1-4 work the same way with a selected row edge in row headings.
	As with columns, steps 1-4 work the same way with a selected row edge in row headings.


	Edit Font Type & Size
	Edit Font Type & Size
	1) Select the desired cell(s), row(s), column(s) or sheet.
	1) Select the desired cell(s), row(s), column(s) or sheet.

	2) On the Home file tab, click the font drop-down.
	2) On the Home file tab, click the font drop-down.

	3) Click a new font.
	3) Click a new font.

	4) Click on the font size drop-down.
	4) Click on the font size drop-down.

	5) Click on a new font size.
	5) Click on a new font size.
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	Edit Font Color
	Edit Font Color
	1) Select the desired cell(s), row(s), column(s) or sheet.
	1) Select the desired cell(s), row(s), column(s) or sheet.

	2) Click the Font Color drop-down.
	2) Click the Font Color drop-down.

	3) Click on a new font color.
	3) Click on a new font color.
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	Edit Fill Color
	Edit Fill Color
	1) Select the desired cell(s), row(s), column(s) or sheet.
	1) Select the desired cell(s), row(s), column(s) or sheet.

	2) Click the Fill Color drop-down.
	2) Click the Fill Color drop-down.

	3) Click on a new fill color.
	3) Click on a new fill color.
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	Create Borders
	Create Borders
	Use borders to make the lines of the spreadsheet grid visible for printing or better viewing.
	Use borders to make the lines of the spreadsheet grid visible for printing or better viewing.

	1) Select the desired cell(s), row(s), column(s) or sheet.
	1) Select the desired cell(s), row(s), column(s) or sheet.

	2) Click the Borders drop-down.
	2) Click the Borders drop-down.

	3) Click on a new fill color.
	3) Click on a new fill color.
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	Format Numbers
	Format Numbers
	There are many ways to format numbers in Excel. 1) Select the desired cell(s), row(s), column(s) or 
	There are many ways to format numbers in Excel. 1) Select the desired cell(s), row(s), column(s) or 
	sheet. 2) Click the desired button in the Number area of the Home file tab. For this example, we’ll 
	change a decimal to a percent.


	Figure
	Similarly, clicking the $ button would turn a number into a dollar amount. Other options exist. 1) 
	Similarly, clicking the $ button would turn a number into a dollar amount. Other options exist. 1) 
	Similarly, clicking the $ button would turn a number into a dollar amount. Other options exist. 1) 
	Click the Number Format drop-down. 2) Click the desired number format. Alternatively, if you don’t 
	see the desired number format listed, click 
	More Number Formats
	… at the bottom of the list.
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	Fill Handle
	Fill Handle
	The fill handle is one of the most time-saving features in Excel. Excel automatically identifies 
	The fill handle is one of the most time-saving features in Excel. Excel automatically identifies 
	common sequences and can complete sequential patterns for you. For example, if you type “1” in 
	one cell and then type “2” in the cell immediately below or immediately to the right of the “1” cell, 
	Excel will list the next consecutive numbers (“3, 4, 5, 6, 7…”) in the cells that follow when using the 
	Fill handle. The Fill handle works for days of the week, months of the year, dates, and many other 
	patterns. It works backward and forward, horizontally across columns and vertically across rows. 
	Manually typing a series is an inefficient use of Excel; let the program do the work for you. 1) Select 
	the cells with the pattern. 2) Click and hold the dark green square, usually located at the lower right 
	corner, of the selected cells. 3 ) Drag the Fill handle across the desired range of cells and release the 
	mouse button. Two examples are shown below.


	Figure
	Align Cell Contents
	Align Cell Contents
	Alignment is used to make the cell contents centered or abutted against the right or left side of a 
	Alignment is used to make the cell contents centered or abutted against the right or left side of a 
	cell. 1) Select the desired cell(s), row(s), column(s) or sheet. 2) Click the desired alignment button.
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	Wrap Text
	Wrap Text
	When the cell’s contents are longer than the cell itself, you may want the cell contents to adjust to 
	When the cell’s contents are longer than the cell itself, you may want the cell contents to adjust to 
	fit the existing column width by expanding the row. This is especially useful when the cell contains 
	a lot of text. 1) Select the desired cell(s), row(s), column(s) or sheet. 2) Click 
	Wrap Text
	 in the 
	Alignment area of the Home file tab.
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	Merge & Center Cells
	Merge & Center Cells
	Merge & Center is useful for center headings over a table. 1) Select the desired cell(s). 2) Click the 
	Merge & Center is useful for center headings over a table. 1) Select the desired cell(s). 2) Click the 
	Merge & Center
	 button.
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	Copy and Paste
	Copy and Paste
	Excel offers a variety of paste options for copied cells. 1) Select the desired cell(s), row(s) or column(s) 
	Excel offers a variety of paste options for copied cells. 1) Select the desired cell(s), row(s) or column(s) 
	to be copied. 2) Click the 
	Copy
	 button. 3) Select the desired cell(s), row(s) or column(s) where you’d 
	like the copied cells pasted. 4) Click the Paste drop-down. 5) Click the desired 
	Paste
	 button. A few 
	of the more common paste options are shown below.
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	Figure
	Figure
	TABLES, FUNCTIONS, CHARTS
	TABLES, FUNCTIONS, CHARTS
	TABLES, FUNCTIONS, CHARTS

	Tables
	 
	Tables make it easier to work with data, including graphs and functions. Plus, you can select 
	columns or rows of data by clicking on the respective table headings.

	1) Select the desired cells to be turned into a table.
	1) Select the desired cells to be turned into a table.

	2) On the Insert File tab, click the 
	2) On the Insert File tab, click the 
	Table
	 button.

	3) If you have column
	3) If you have column
	 
	headings for your data,
	 
	ensure the “My table
	 
	has headers” box is
	 
	checked. Click 
	OK
	.


	Figure
	Sort
	Sort
	 
	Sort is used to arrange data from largest to smallest or vice versa. In a table, this feature is already 
	built into the column headings. For this example, we’ll sort smallest to largest by data in the 
	Tuesday column.

	1) Click the desired column drop-down in the table’s
	1) Click the desired column drop-down in the table’s

	 column headings.
	 column headings.

	2) Click 
	2) Click 
	Sort Smallest to Largest
	.

	3) Click 
	3) Click 
	OK
	. The table is now sorted based on the

	 re-ordered data in the Tuesday column.
	 re-ordered data in the Tuesday column.


	Figure
	To remove a sort, click the 
	To remove a sort, click the 
	To remove a sort, click the 
	undo
	 button.


	Filter
	Filter
	 
	Filter is used to “filter out,” e.g., remove certain data from view. When you filter data, nothing is 
	erased; rather, the data simply becomes non-viewable as long as the filter is on. You can turn off 
	filters at any time. In a table, this feature is already built into the column headings. For this example, 
	we’ll filter out all data from the table except for ECC and SCU rows.

	1) Click the desired column drop-down in the table’s column headings.
	1) Click the desired column drop-down in the table’s column headings.

	2) Click the 
	2) Click the 
	(Select All)
	 box to uncheck it. This will uncheck all values.

	3) Click the boxes for ECC and SCU.
	3) Click the boxes for ECC and SCU.

	4) Click 
	4) Click 
	OK.
	 The whole table is now filtered of data not pertaining to the ECC and SCU.


	Figure
	Figure
	To turn off the filter, 1) Click the column drop-down with the filter icon     . 2) Click Clear Filter From 
	To turn off the filter, 1) Click the column drop-down with the filter icon     . 2) Click Clear Filter From 
	To turn off the filter, 1) Click the column drop-down with the filter icon     . 2) Click Clear Filter From 
	“Unit.” 3) Click OK. The filter is now removed from the table.
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	Basic Functions
	Basic Functions
	 
	Functions make Excel powerful at making your life easier. Functions can perform math, find data in 
	a column, use logic to determine whether to count individual values for a calculation and so much 
	more. Excel users looking to become stronger users are advised to learn more functions. Two basic 
	functions, SUM and AVERAGE, are shown below.

	SUM
	 
	As the name implies, the SUM function is used to add the values in a selected range. A “Total” 
	column or row in a table is the perfect location to use the SUM function. The steps below include 
	creating a “Total” column in the table, although these steps (1 and 2) are not required to use the 
	SUM function. 1) In the cell adjacent to the last table column heading, type “Total.”  2) Press 
	Enter
	. 
	Excel will automatically create a new table column for you. 3) The cell below the heading is where 
	we use the SUM function. As that cell is already selected, go to the Formulas File tab and click 
	AutoSum
	. All row values are automatically selected, and the formula is displayed. 4) Press 
	Enter
	. 
	The sum of the first row values is now displayed. 5) To use the SUM function for all rows in the table, 
	use the Fill handle, or click the 
	AutoCorrect
	 button that appeared after clicking Enter. 6) Click 
	Overwrite all cells in this column with this formula
	. The sum of the row values is now displayed 
	for all rows.


	Figure
	Figure
	AVERAGE
	AVERAGE
	 
	The AVERAGE function displays the mean (average) of all numbers in a selected range. For this 
	example, we’ll calculate the average of all values in the table but in a cell by itself. The AVERAGE 
	function does not need to be used separately from a table. This example is shown purely to 
	demonstrate a different but equally common approach for using functions. Also, the steps below 
	include creating an Average: label, although steps 1 and 2 are not required to use the AVERAGE 
	function. 

	1) Click any cell that is several cells to the right of the table (so the table does not automatically 
	1) Click any cell that is several cells to the right of the table (so the table does not automatically 
	try to add it as a new column or row). In the cell, type “Average:”  

	2) Press 
	2) Press 
	Tab
	. One cell to the right is now selected. 

	3) In the Formulas File tab, click the 
	3) In the Formulas File tab, click the 
	AutoSum drop-down
	. 

	4) Click A
	4) Click A
	verage
	. The cell now shows the AVERAGE formula with empty parenthesis. This 
	means that Excel is waiting for a data range to be selected. 

	5) Select a range of cells that contains the data. In this example, we’ll use all the data in the 
	5) Select a range of cells that contains the data. In this example, we’ll use all the data in the 
	table, excluding headings and the Total column. Simultaneously, the cell with the formula 
	will automatically insert the range you’ve selected into the formula. 

	6) Press 
	6) Press 
	Enter
	. The average of all values in the table is now displayed.
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	Basic Charts
	Basic Charts
	 
	A chart is a visual representation of data. Complex data create complex charts. Simple data create 
	simple charts. As a rule, the simpler, the better. To create a chart, first format data to be as simple as 
	possible. Pie Chart and Bar Chart examples are shown in this section. For both examples, based on 
	the table used in previous examples, we decided that we only want our charts to display the data in 
	the Totals column. Plus, to ensure our data is labeled correctly, we will also use the row headings in 
	the Unit column. 

	1) Copy the Unit table column and paste values several cells right of the table.  
	1) Copy the Unit table column and paste values several cells right of the table.  

	2) Copy the Total table column and paste values to the immediate right of the Unit column 
	2) Copy the Total table column and paste values to the immediate right of the Unit column 
	values.  

	3) Select all newly pasted cells, and click the Table button on the Insert File tab. We will now 
	3) Select all newly pasted cells, and click the Table button on the Insert File tab. We will now 
	use this new table for charts in the following examples.
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	Pie Chart
	Pie Chart
	 

	1) Select the table. 
	1) Select the table. 

	2) On the Insert File tab, click the 
	2) On the Insert File tab, click the 
	Insert Pie Chart
	 button. 

	3) Click on the 
	3) Click on the 
	Pie
	 button. The data is now converted into a pie chart. Clicking on the chart title 
	will allow you to change the heading. This chart may be copied and pasted, including into a 
	Word document or a PowerPoint.
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	Bar Chart
	Bar Chart
	 

	1) Select the table. 
	1) Select the table. 

	2) On the Insert File tab, click the 
	2) On the Insert File tab, click the 
	Insert Bar Chart
	 button. 

	3) Click on the 
	3) Click on the 
	Clustered Column
	 button. The data is now converted into a bar chart. Clicking 
	on the chart title allows you to change the heading. This chart can be copied and pasted, 
	including into a Word document or a PowerPoint.
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	ORIENTATION & PRINT
	ORIENTATION & PRINT
	ORIENTATION & PRINT

	Orientation
	Orientation
	 
	Orientation allows you to change how a page is arranged to print. The options are either Portrait 
	(taller) or Landscape (longer). An Excel document will be set to Portrait by default, so use this 
	option to change to Landscape. 

	1) Click the File tab named 
	1) Click the File tab named 
	File
	. 

	2) Click 
	2) Click 
	Print
	. 

	3) Click 
	3) Click 
	Portrait Orientation
	. 

	4) Click 
	4) Click 
	Landscape Orientation
	. The page is now set to print sideways/landscape.
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	Printing on One Page
	Printing on One Page
	Printing on One Page
	 
	Large amounts of data often go off a single page in Excel. Luckily, you can make it fit on one page 
	for printing.  

	1) Click the File tab named 
	1) Click the File tab named 
	File
	. 

	2) Click 
	2) Click 
	Print
	. 

	3) Click 
	3) Click 
	No Scaling
	. 

	4) Click 
	4) Click 
	Fit Sheet on One Page
	. The page is now set to print on one page. 

	Be aware, however, that too much data squeezed onto one page may make the font so small that it 
	Be aware, however, that too much data squeezed onto one page may make the font so small that it 
	becomes unreadable. In these circumstances, you may try 
	the Fit All Columns on One Page or Fit 
	All Rows on One Page buttons to make a couple of
	 pages of readable information.
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	RESOURCES
	RESOURCES
	RESOURCES
	 
	The best resource is Google. Even expert Excel users do a Google search that begins with, “Excel, 
	how do I…” If Google doesn’t help, ask colleagues. If all else fails, submit a help desk ticket.








